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INTRODUCTION

The APRA/AMCOS Clearance Facility [CF] was introduced in July 2001, with the purpose of streamlining the process by which record companies obtain mechanical copyright 
information for their releases, replacing the system of circulating paper label copy. 

Record companies [commonly referred to as clients] submit the details of their releases [productions] to CF electronically, either by entering them manually via a web interface or by 
submitting bulk transactions using Electronic Data Interchange [EDI] via FTP. For each production submitted to CF, clients must provide the following information:

For the production itself -
Title, performer, catalogue number, release date, price, pack quantity, number of tracks, country of release (CF covers releases in both Australia and New Zealand – some record 
companies operate in both territories). Further information, such as foreign catalogue number, country of manufacture, duration, etc can also be provided if the client wishes.

For each track included on the production – 
Title, writer(s), performer (if the production is a compilation), copyright status (selected from Copyright, Public Domain, Spoken Word, Paid Direct). There are also options to provide 
further details, such as publisher, arranger, track type, etc.

CF CLIENTS

CF receives submissions from a number of different types of client:

Category 1 – major record companies (EMI, Sony BMG, Universal and Warners)
Category 2 – smaller record companies whose productions are licensed by AMCOS
Category 3 – ‘sundry’ releases licensed by AMCOS
Digital Delivery – albums made available for download via the internet are reported through CF

The category 1 clients submit most of their productions via EDI, most category 2 clients use the CF website, although a few also use EDI, category 3 productions are entered manually 
by AMCOS staff, and the digital delivery clients’ productions are created from the sales reports they submit to AMCOS (see page 45 for full details on the processing of digital delivery 
productions).

Multiple clients per production
A production released by one client may also be released by another client in a different territory, or even in the same territory, either where a catalogue has changed hands, or where 
a client is a reseller, e.g. Doubleday. Once the production has been submitted to CF by one client, there is no need for other clients to register the production separately – they can 
simply attach their details to the existing production. Thus one production might have multiple clients attached to it. A separate Prescribed Notice [PN] is created for each client 
attached to a production, showing the ownership details for all works included on the production and the associated mechanical royalty obligations for the client concerned.

Primary Ownership
Where a production has multiple clients attached, one client is designated as the Primary Owner, and only this client is able to amend the details of the production, its associated 
tracks, etc. The Primary Owner is usually the client who first submitted the production, but the primary ownership of a production can change: for instance, if a production is submitted 
by a Category 2 client, and a Category 1 client subsequently attaches their details, the Category 1 client automatically becomes the Primary Owner; and if a catalogue is transferred 
from one client to another, CF staff are able to transfer the primary ownership. 
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PRODUCTIONS

Production status
For each client attached to a production, a status is displayed:

Pending Production is within the 10 working day clearance cycle prior to receiving its first PN 1

Hold at the editing stage, prior to receiving first PN, data submitted by client was found to be seriously flawed 2

Changed Significant details of production have been changed prior to receiving first PN, client needs to resubmit production

Active PN production has received at least one PN

Corrected details on production were incorrect, production has been terminated (a new version of the production should have been created and resubmitted to CF)

Withdrawn production was submitted to CF but then removed from client’s catalogue prior to release

Deleted production has been deleted from client’s catalogue (i.e. is no longer available for sale)

Active applies only to Digital Delivery productions, indicates that production has been edited by CF staff and made available for publishers to view

1 The Pending status is also used where digital delivery sales have been attached to an existing (physical) production which had been marked as Deleted by its Primary Owner. See 
page 50 for further details.

2 A production will be placed on hold if errors/omissions in the data submitted by the client make it impossible for the editing to be completed. Common examples of problems with data 
are: missing or incorrect writer information, medleys formatted incorrectly, tracks flagged as Spoken Word where music is featured, etc. The client is contacted as soon as the 
production is put on hold and such productions are chased up regularly. Every effort is made to ensure that productions are corrected and resubmitted as quickly as possible.

Where multiple clients have attached release details to a production, the production status reflects the status of the primary owner, but a separate status is shown for each client as 
well, so it is possible that the production status may differ from an individual client’s status. For instance, in the screenshot below the Primary Owner has marked the production as 
Deleted, and this is reflected in the Production Status field, but the production is still active for the second client attached to it:
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PRODUCTION CATEGORIES AND FORMATS

Categories

There are four categories available for productions in the Clearance Facility, and the category selected by the client determines the royalty rate for the production. The categories are:

Category Description APRA ID starts with…

Audio Covers productions containing only audio material, e.g. standard CDs, cassettes, vinyl, DVD/A, etc. AU

Video Covers productions containing only audiovisual material, e.g. DVD, video cassettes VI

Karaoke Covers productions containing audio material plus synchronised displayed lyrics, e.g. CD/G KA

Mixed Format Covers productions containing a mixture of audio and audiovisual material, e.g. CD/DVD packs, 
DualDisc, CD albums featuring bonus video tracks. Excludes CD Singles (see notes, page 4). MF

Mixed Format Productions – additional information

The concept of Mixed Format productions was introduced to the Clearance Facility following the implementation of the AMCOS Physical Product Agreement in April 2006. Designed to 
cover the increasing number of releases which feature both audio and audiovisual material, such as CD/DVD packs, DualDisc, etc, the Mixed Format category allows clients to label 
each track on the production as being either audio or audiovisual, and to pay the appropriate royalty rate on a track-by-track basis.

In terms of the way that Mixed Format productions are submitted to the Clearance Facility, the details are entered in the same way as for AU, VI or KA productions, the only major 
difference being the addition of the ‘Track Type’ signifier, which is displayed in the Production Details screen in CMS like this:

and is reflected on Prescribed Notices by the application of the different royalty rates:

3

Note that for a DualDisc release, 
clients enter the Pack Quantity 
(number of discs) as 1, but when 
entering the track details, are able to 
use the ‘Disc’ number field to show 
side 1 and side 2.
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Format
The following options are available to clients when selecting the physical format for a production:

Soundtrack Release with Film
This format was introduced following the implementation of the AMCOS Physical Product Agreement in April 2006. Designed to cover the release of a film, packaged with its 
soundtrack (e.g. in a DVD/CD pack, or on DualDisc), the selection of the Soundtrack Release with Film format by the client means that, although the production is entered under the 
AU category, a lower royalty rate is applied. Only the audio soundtrack element of the production is entered by the client and the reduced royalty rate reflects the fact that this element 
is only part of the overall package.

4

FORMAT
Cassette AU

Cassette Single AU

CD AU

CD+Graphics KA

CD Single1 AU

DCC AU

DVD VI, AU, KA

Vinyl LP AU

Minidisc AU

Mixed Format2 MF

Video VI

Soundtrack Release with Film3 AU

Universal Media Disc VI, AU

Vinyl Single AU

NOTES

1 As specified in the AMCOS Physical Product Agreement 
(April 2006), CD Singles must be submitted as AU, even if 
audiovisual material is included. 

2 If the production is Mixed Format, both the Category and 
the Format must be set to Mixed Format.

3 See notes below on the ‘Soundtrack Release with Film’ 
format.
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THE CLEARANCE CYCLE

Below is an overview of how copyright clearance is achieved using the CMS Clearance Facility. (This information applies only to physical product – for details on how digital delivery 
productions are processed, see page 45.)

1. The Production is submitted
Client submits production electronically to CMS. This begins a ten working day period, during which publishers can make claims, prior to the generation of a Prescribed Notice on 
the eleventh working day.

2. The Works Matching Process
Works submitted by Client are subjected to APRA’s automated Works Matching Process, whereby Title, Writer, Performer and other variables are compared to works already in 
CMS. If the appropriate work is found, it is attached automatically (along with current ownership information) to the production. If the work is not found, a new work is created 
(without ownership details).

3. APRA/AMCOS’ two day editing period
CF staff have a two day period during which the results of the automated matching process are manually checked to ensure that the correct works have been attached to the 
production. If an incorrect work has been attached, it is substituted for the correct one. If a new work has been created, it is checked to make sure that the new work is not a 
duplicate of an existing one – if it is, the two works are merged; if the new work is legitimate, the details are researched and edited to ensure that the title/writer/performer/etc 
information is correct.

4. Publishers’ claiming period
After two days, the production is made available for publishers to view via CMS or via EDI download. Publishers are able to see the information submitted by the record company, 
alongside the details of the works selected by the CMS matching process. They can also see the mechanical ownership details currently held by APRA/AMCOS and can enter or 
amend their ownership, again either via CMS or via EDI. Publishers are also able to request that a work on a production be substituted for (or merged with) another work in CMS.

5. Prescribed Notice
At the end of the ten working day period a Prescribed Notice is generated for the production, displaying the most current mechanical ownership information for each work. Both 
client(s) and publishers are advised of the creation of the Prescribed Notice through an Event Notification (see page 30).

If the ownership of any track within a production changes, a new PN is created for the production, displaying the updated information, and these subsequent PNs are generated 
once a week, on Friday evening, so the new PNs are ready for viewing /downloading at the start of the following week.

NOTE
AMCOS-licensed Productions that are entered internally by AMCOS staff are not subject to either the Works Matching Process or the two day editing period. Works are manually 
selected directly from the CMS database, or new works created if no matching work currently exists in CMS. This removes the need for the editing process, and as a result these 
productions are immediately available for publishers to view and claim. The first PN is still created ten working days after the production’s creation.
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OWNERSHIP

There are three ways in which mechanical copyright ownership can be represented in CMS:

MDOF – Mechanical Division of Fee

MDOFs are created based on publisher registrations and other confirmed mechanical ownership information. Shares shown in MDOFs are reflected on Prescribed Notices, enabling 
the payment of mechanical royalties.

MREG – Mechanical Registration

When registering a work in CMS, publishers must provide full information concerning their ownership claim, including writer, original publisher and subpublisher details. When a work 
with a registration becomes mechanically active (for example, is attached to a production in CF), AMCOS staff convert the registration to an MDOF and the ownership is added to the 
PN, allowing mechanical royalties to be paid. A registration which has been added to the MDOF on a work is marked as obsolete, but remains recorded on the work permanently.

Registrations can be added to works from the Claim By Work screen (see page 20), the Claiming window (page 11), the Production Details screen (page 25) and through the 
Publisher Registration (Works Information) screen (page 22).

MROC – Mechanical Right Ownership Claim

MROCs can only be made for works attached to productions in CF. An MROC is an interim claim, to be made only when the full information required for a registration cannot be 
provided. MROC shares are included on Prescribed Notices, so payment of mechanical royalties can be made based on MROCs.  However, MROCs are removed after six months, so 
it is the publisher’s responsibility to submit a registration for their share within that time (see page 35 for further information).

NOTE: MROCs supersede both MDOF shares and MREGs. If a publisher has an existing MDOF share and submits an MROC for a different percentage, it is the MROC share that will 
be reflected on the Prescribed Notice, and CF staff will remove the MDOF share. If a publisher has an existing active registration and submits an MROC for a different percentage, the 
registration will be made obsolete.

MROCs are added to works through the Claiming window (see page 11 for further information on the Claiming window, page 17 for information on adding MROCs to works).

MECHANICAL DISPUTES

If the total mechanical ownership claims on a work attached to a production in CF exceed 100%, the mechanical dispute flag is triggered and the ownership for the work is reported on 
the Prescribed Notice as AMCOS Dispute. It is then up to the publishers concerned to resolve the dispute – publishers can reduce their share on the work temporarily by submitting an 
MROC (see page 17) or permanently by submitting a new registration (see page 22) or, if they should not be claiming any share on the work, they can submit a disclaim (see page 
14).

NOTE: The mechanical dispute flag on a work is reactive, in that it is triggered by the ownership exceeding 100%. The setting of the flag does not in itself cause the work to be shown 
as being in dispute, nor does the flag being set necessarily indicate that the work is currently in dispute. For instance, if the ownership is reduced to below 100%, the flag will remain 
set until removed manually by AMCOS staff, but the Prescribed Notice is amended to show the new total share.

6
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PRESCRIBED NOTICES

CREATION OF PNs

The initial Prescribed Notice for a production is created at the end of the ten working day clearance cycle (see page 5), and reflects the latest ownership details received by 
APRA/AMCOS for each track on the production.

Following the creation of the initial PN, if the ownership of any track on the production changes, a new PN will be created - as soon as the ownership details on the work are changed 
in CMS, a new PN due date is set, and the new PNs are created at the end of each week, on Friday night.

The reason for the new PN being created is shown and where the reason is ‘Ownership Change’, the works which have been changed are flagged so that users can check the 
amendments quickly and easily:

DELETION OF PNs

The effective date column shows the date that a new PN was created, and the Terminated column shows the date that an old PN ceased to be effective. Terminated PNs are deleted 
from CMS/CF after six months, with the exception of a) the first PN created for each client  attached to a production, and b) any PN used for invoicing sales for category 2 or 3 clients – 
these PNs are retained permanently.

[NOTE: As each new PN is created for a production, it is given a sequence number. PN number 1 will always be assigned to the initial PN created for the production’s primary owner, 
but following that, the numbering sequence runs across all clients attached to a production, so for example, PN number 2 may be assigned to the primary owner for an ownership 
change, PN number 3 may be the first PN for a second client attaching to the production, PN numbers 4 and 5 may be ownership change PNs for both clients, etc. 

When viewing PNs in CMS/CF, if it appears that numbers in the sequence have been skipped, this will be due either to multiple clients being attached to the production (scrolling down 
in the top section of the PN window/tab will show details for other clients), or to terminated PNs having been deleted, as per the information above.

7
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ACCESSING THE CLEARANCE FACILITY

Publishers can access the Clearance Facility through APRA/AMCOS’ Copyright Management System (CMS) database - from the opening Publisher’s Work Search screen, clicking 
File > Clearance Facility [ALT F + L] opens the CF menu:

The available options are:

Claim By Production: Allows you to retrieve a list of productions according to various general criteria, e.g. productions submitted within a date range, with/without PNs, with multiple 
clients attached, etc. – see page 9 for further details.

Claim By Work: Allows you to retrieve a list of productions based on works-related criteria, e.g. productions where you have/have not claimed works (page 20)

Production Inquiries: Allows you to search for productions using more specific queries – title, artist, catalogue number, client (page 23).

Event Notifications: Lists CF-related activities such as submission of productions, creation of PNs, submission of EDI files, etc (page 30)

EDI: Allows you to request downloads of data from CMS/CF via FTP (page 36).

8
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CLAIM BY PRODUCTION

The top section of the Claim Works – Production List window offers various options and filters to allow you to retrieve the productions you wish to view:

1) New Only (no PN)
Shows productions submitted within the specified date range which have not yet received their first PN and also digital delivery productions which have been edited and submitted 
within the date range (see page 45 for further information on digital delivery productions in CF).

NOTE: by default, the ‘From’ date is set to two days prior to the current date/time. If you do not change the ‘From’ date, you will only see:
a) productions that were created internally by APRA/AMCOS staff, which are not subject to the two day editing window (see page 5 for further information), 
b) digital delivery productions that were edited and submitted by APRA/AMCOS staff within the date range, and
c) productions that were submitted by external clients before the time shown in the ‘To’ field two days previously.

2) With PN
Shows productions submitted within the specified date range which have received at least one Prescribed Notice. The ‘From’ date must be set for at least ten working days before 
today’s date, as it takes two weeks for productions to receive their first PN. NOTE: digital delivery productions do not receive PNs, so will not be listed in this view.

3) Multiple Clients
Shows productions submitted within the specified date range where multiple clients are attached.

4) On Hold
Shows productions submitted within the specified date range which have been placed on hold by CF staff due to insufficient or inaccurate data.

The ‘Client Type’ dropdown allows you to choose to see productions from all clients, or only those from Category 1, Category 2, Category 3 or Digital Delivery clients.

The ‘Catalogue’ dropdown allows you to see all productions returned from the other criteria, or to choose to see only current releases, or only back catalogue releases (those where 
the release date was more than six months prior to the date they were submitted to CF).

9
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Once a set of results has been retrieved, the following information is displayed for the productions listed:

When a production is highlighted on screen, the buttons at the foot of the screen perform the following functions:

Client: If, in the Client column, an asterisk appears before the record company’s name, this indicates that there are other clients attached to the production; clicking the Client button 
brings up a pop-up window displaying all the clients currently attached to the production (see page 18 for further details).
Prod Details: opens up the Production Details screen (see page 25 for further information on this screen).
Print: allows you to print the retrieved results in list form.
Detailed Print: prints a report listing all tracks on the highlighted production, along with associated MDOF/MROC/MREG information (for all publishers).
Print Inquiry: produces a printed version of the Prescribed Notice for the highlighted production.
Close: closes the current window.
View PN: brings up a pop-up window displaying the Prescribed Notice(s) for the production (see page 19 for further details).
Keyword: Allows you to search for a particular production among the results. (There is also a column-specific ‘Find’ function available – right-click on a column header, e.g. Production 
Title, Client, etc., and select Find from the menu to search for a keyword in that particular column.)

10

Rush: If the client has specified that a production is a ‘rush release’, a Y 
will appear in this column, and the production will appear as the first item 
in the list. NOTE: labelling a production as a rush release does not make it  
pass through the clearance cycle any more quickly – the standard ten 
working day cycle still applies.

Submitted: Date production was submitted to CF by client.

Production title / artist / catalogue number.

Client: shows the Primary Owner of the production; an asterisk indicates 
that one or more further clients are also attached.

Ctry: Country of release – either AU or NZ

Tracks: The total number of tracks on the production

Claimed: The number of tracks on the production which have some form 
of mechanical claim (MDOF, MROC or MREG) attached. NOTE: This field 
reports claims by ALL publishers, not just your own company.

By You: Indicates with a ‘Y’ if you have mechanical claims (MDOF, 
MROC or MREG) attached to any works on the production. 

Seen: Indicates with a ‘Y’ if you have previously looked at the production 
from this view, to allow you to keep track of what you have done.

Status: The current status of the production (see page 2 for further 
information on production status.

ID: The APRA ID assigned to the production.

Double-clicking on a production listed on this screen opens the Claiming 
Window, from which you can view existing claims on, add MROCs or 
registrations to, or remove existing claims from, all works currently 
attached to the production, as well as request substitutions for works 
incorrectly attached to the production – see page 11 for further details.
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CLAIMING WINDOW

This window gives you access to a number of key CF functions:
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Substitute: Tick this 
box to request a work 
be substituted on the 
production – see page 
13 for details.

AU% / NZ%: Your current 
claims (MROC/MDOF/MREG) 
for Australia and New Zealand 
are shown here.

All Claims: Click this 
button to view the All 
Claims window, showing 
details of all current 
MROC/MDOF/ MREG 
claims for all publishers 
on this work – see page 
12 for details.

Disclaim: Tick this box 
to remove your claim 
from the work – see 
page 14 for details.

Claim: Tick this box to 
add a new MROC to 
the work – see page 17 
for details.

Record Company Data:
This section of the 
screen shows the track 
details as submitted by 
the client.

APRA Data: This section 
of the screen shows the 
details of the work 
attached to the 
production by APRA.

Use this scrollbar 
to view other works 
on the production.

Double-click on the 
APRA ID to open the 
Works Information 
screen.
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ALL CLAIMS WINDOW

The All Claims window shows details of all mechanical ownership claims – for all publishers – that are currently attached to a work - if there is an MDOF, this is shown in the top 
section, any MROCs are shown in the middle section, and any registrations (whether active or obsolete) are shown in the bottom section.

12
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REQUESTING A SUBSTITUTION

The CF Substitute function, available through the Claiming window, has two purposes:
1) If you believe that an incorrect work has been attached to a production, you can use the substitution function to request that the work be swapped for another one.
2) If you believe that there is a work in CMS which is a duplicate of a work attached to a production, you can use the substitution function to request that the two works be merged 
together (this is of particular use where a registration of yours which should be attached to the work on the production is in fact on a different work in CMS).

To use the substitution function, follow the steps outlined below:

13

1) Tick the 
Substitute 
box.

2) The APRA ID field is 
opened for editing. If you 
know the ID for the work you 
want to substitute for, you can 
enter it here; otherwise, type 
the work title here and hit 
Enter to open the normal 
Works Search window…

3) Use the Works Search to find the work that you believe should be attached to the 
production, click OK to return to the production, then click OK again. The following dialogue 
box will appear…

4) Select the appropriate option and hit OK to submit the substitution request. CF staff print 
and process substitution requests on a daily basis. If there is any concern that a substitution 
request is incorrect, i.e. that works should not be swapped/merged, CF staff will contact you 
(and also any other publishers who may have an interest) to confirm the details.
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DISCLAIMING WORKS

You can use the Disclaim function, available from the Claiming window, to remove your claim from a work.

To disclaim a work, simply tick the Disclaim box and hit OK [ALT + O]. You will be asked to confirm the territory you wish to disclaim for:

DISCLAIMING AN MROC
If you have wish to remove an MROC from a work, submitting a disclaim will cause your MROC to be deleted immediately. A new PN will be created at the end of the week for all 
productions to which the work is attached.
 

14
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DISCLAIMING AN ACTIVE REGISTRATION
If you have an active registration attached to a work (i.e. your mechanical share has been registered but not yet added to the MDOF), but wish to cancel this registration, submitting a 
disclaim will cause the registration automatically to be marked as obsolete.

DISCLAIMING AN MDOF SHARE
If you have an existing MDOF share, submitting a disclaim adds an MROC for 0% to the work on your behalf:

You will be asked to select a reason for your disclaim:

1) Selecting ‘Work no longer controlled by publisher’ indicates that your existing claim is incorrect and that you should not have been credited with a share on the work. These 
disclaims are generally processed immediately by CF staff from the daily Disclaims report. If CF staff believe that you may have disclaimed the work in error, they will contact you to 
confirm the details.

2) Selecting ‘Catalogue no longer controlled by publisher’ indicates that you were once entitled to a share on the work, but are not any longer, due to the transfer of ownership of the 
publishing catalogue. These disclaims are dealt with by catalogue administration staff; if a catalogue has been transferred, ownership is, wherever possible, amended on a catalogue-
wide, rather than a work-by-work basis.

15
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APRA staff process a Disclaims report on a daily basis and will remove your share from the MDOF. A new PN will be created at the end of the week in which you have submitted your 
disclaim. 

For all types of disclaim (MDOF/MROC/MREG), if the work concerned is on multiple productions, new PNs will be generated for all of them, so you only need to disclaim the work 
once.

If you have a PDOF share, or have a performing registration, you will be asked if you wish to disclaim this as well:

The Publisher Services Department regularly run a report in order to process these requests.

16
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CLAIMING WORKS

The Claim function, available from the Claiming window, can be used in a number of different ways. 

Adding an MROC to establish a claim
The main purpose of the Claim function is to add an MROC to a work. As per the information on page 6, an MROC allows a publisher to establish an interim claim on a work in the 
absence of the full ownership details that are required for a registration. Where you currently have no claim (MDOF/MROC/MREG) attached to a work, by ticking the Claim box and 
entering percentages for Australia and/or New Zealand (see highlighted section in screenshot below), you are able to add an MROC which will allow you to be paid mechanical 
royalties (providing that the total claims on the work do not exceed 100%, meaning that the work is in mechanical dispute). 

Amending an MDOF share
If you currently have a share in the MDOF on a work, but the percentage shown there is incorrect, you can either re-register the work, following which the registration will be reported 
to APRA/AMCOS staff and the MDOF subsequently amended, or, if you are not able to submit a new registration immediately, you can submit an MROC for the correct percentage. 
The percentage entered for the MROC will override the MDOF share on the Prescribed Notice, thus communicating the new share to the client. CF staff run a weekly report which 
shows any works where a publisher has an MDOF share and an MROC for different percentages and in processing this, your MDOF share will be deleted, leaving just your MROC in 
place. It is imperative, therefore, that if you use the Claim function in this way, you make sure that you submit a new registration within six months of the submission of the MROC, 
otherwise your MROC will be removed by the Timebombing process (see page 35 for details), leaving you with no claim on the work.

Rendering an active registration obsolete
If you currently have an active registration attached to a work but the share claimed in that registration is incorrect, submitting an MROC for the correct percentage will cause the 
registration to be made obsolete. You must then submit a registration for the correct share within six months, otherwise the Timebombing process will result in the deletion of your 
MROC and the removal of your share from the work.

NOTE: If you submit an MROC which overrides an existing MDOF share or makes a registration obsolete, but discover that the MROC was incorrect, you have two options:
i) re-register the work to re-establish the original claim or
ii) if you are unable to re-register immediately, contact mech@apra.com.au with full details (including work ID and registration claim number) and ask for the MDOF share 

or registration to be reinstated.
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The ‘Select Pub’ dropdown 
allows you to add an MROC 
for a subsidiary publishing 
company while logged on to 
CMS as the ‘parent’ 
publisher.
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CLIENT WINDOW
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The top section of this window 
shows details for all Category 1, 
2 and 3 (physical product) clients 
who have attached their release 
details to the production. Their 
country of release, date of 
release and PPD code/price 
details are displayed, along with 
the date of any PN updates that 
may be due.

The lower section of this window 
shows any Digital Delivery clients 
by whom sales have been 
reported for the production. For 
further details on Digital Delivery 
clients and productions, see 
page 45.
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PRESCRIBED NOTICE WINDOW

This window displays all available Prescribed Notices for a production (see page 7 for further general information on PNs). The top section of the window shows details for the PN itself 
– client, production release date, PN start/end date, etc.  The middle section shows, for the PN highlighted, details of the featured tracks, while the bottom section shows, for a 
highlighted track, the current ownership details. 

The ownership displayed in the bottom section may represent either an MDOF share or an MROC – clicking the All Claims button will display further, more detailed information (see 
page 12 for further information on the All Claims window).
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Use this scrollbar to view 
ownership details for all tracks on 
the PN highlighted in the section 
above.

Use this scrollbar to view other 
PNs where available (these may 
be earlier PNs for the same 
client, or PNs for other clients 
attached to the production) 
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CLAIM BY WORK 

Like the Claim Works – Production List window, the Claim Works – Work List window offers various options and filters to allow you to retrieve the productions you wish to view:

1) Unclaimed
This view displays all productions submitted within the specified date range, along with all the works on those productions on which you do not currently have a claim attached. 

2) Unclaimed & Claimed
This view displays all productions submitted within the specified date range, along with all the works on those productions, whether you have claimed them or not.

3) Claimed only
This view displays all productions submitted within the specified date range, along with all the works on those productions on which you currently have a claim (MDOF/MROC/MREG) 
attached.

4) In Prods With PNs
This view displays all productions submitted within the specified date range which have received a PN, along with all the works on those productions, whether you have claimed them 
or not.

5) Multiple clients
This view displays all productions submitted within the specified date range that have release details for more than one client attached to them, along with all the works on those 
productions, whether you have claimed them or not.

6) In Prods On Hold
This view displays all productions submitted within the specified date range which have been placed on hold due to insufficient or inaccurate data, along with all the works on those 
productions, whether you have claimed them or not.
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Once a set of results has been retrieved, for the productions listed, the following information is displayed:

When a production is highlighted on screen, the buttons at the foot of the screen perform the following functions:

Client: brings up a pop-up window displaying all the clients currently attached to the production (see page 18 for 
further details).
All Claims: brings up the All Claims window  (page 12). 
Prod Det: brings up the Production Details window (page 25).
Print: allows you to print the retrieved results in list form
Detailed Print: prints a report listing all tracks on the highlighted production, along with associated MDOF/MROC/MREG information (for all publishers)
Print Inquiry: produces a printed version of the Prescribed Notice for the highlighted production
Find: Allows you to search for a particular production among the results, using the Title, Catalogue or Artist fields. (You can also use the ‘Find’ function for this – see page 10)
New Reg: brings up the Publisher Registration window, allowing you to add a registration immediately if you have the required details available (page 22).
Copy Prev Reg: brings up the Publisher Registration window with the title/writer details of the current track, but with the registration details filled out as per the last registration you 
entered. This function allows you to add identical registrations for multiple works on a production quickly and easily.
Close: closes the current window
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Double-clicking on a work opens the … 
window 

Rush: If the client has specified that a production is a ‘rush 
release’, a Y will appear in this column, and the production 
will appear as the first item in the list. NOTE: labelling a 
production as a rush release does not make it pass through 
the clearance cycle any more quickly – the standard ten 
working day cycle still applies.

Date of submission, production title, country of release, 
catalogue number, client, disc/track numbers, work title (as 
submitted by the record company), writers, artist.

Your AU % / Your NZ %: If you have an existing claim 
(MROC or MDOF or Active MREG) on a work, whether for 
your ‘parent’ publisher or any subsidiary company, the 
percentages for Australia and New Zealand are shown here.

Total Au % / Total NZ %: The total percentage claimed by all 
publishers for a work is shown here.

MDOF / MROC / Mech Reg: A ‘Y’ in any of these columns 
indicates that a work has an MDOF/MROC/active MREG 
attached – these may be for any publisher(s), not necessarily 
for you.

ID: The APRA ID assigned to the production.

Status: The current status of the production (see page 2 for 
further information on production status.

Double-clicking on a work in this 
screen opens the Claiming 
window (see page 11)
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PUBLISHER REGISTRATION WINDOW

This window allows you to add a registration directly to a work. For further details on how to complete registrations, see the general CMS Manual issued by APRA/AMCOS’ Publisher 
Services.
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PRODUCTION INQUIRIES

The Production Inquiries screen allows you to search for specific productions by title (or APRA ID, if known), catalogue number, performer or client, or by using a combination of these.

NOTE: Ticking the On Hold Productions box on this screen renders the other search terms obsolete and brings up a list of all productions currently on hold – see page 2 for further 
details on productions on hold.

SEARCHING FOR PRODUCTIONS

Prod Title: Enter the title of the production(s) you wish to see. You can perform a leading-edge search in this field by entering (at least) the first four characters of the title, followed by 
an asterisk, e.g. BRILLIANT* {if a production title starts with an article, e.g. THE, A, AN, etc, this is ignored}. Including an asterisk at the beginning and end of a text string will return all 
productions containing that text string in the title eg *diato* would return production “Radiator” AU00101204. For text strings <4 characters, substitute asterisk(s) for the missing letters. 

The screenshot below shows the results of a leading-edge title search:
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Catalogue No: Enter the full catalogue number of the production you wish to see. As with the title search field, you can perform a leading-edge search in this field, but again, you 
should enter as many characters as possible to avoid returning too many results.

Artist Name: To search for productions using the Artist Name field, if you enter a full performer name, you have to enter it exactly the client who submitted the production did, i.e. if the 
client submitted the performer as SINATRA, FRANK, then searching under SINATRA FRANK will not work. You can, however, enter SINATRA* to find all productions entered under 
FRANK SINATRA. SINATRA FRANK / SINATRA, FRANK, etc., as shown in the screenshot below:

NOTE: For all leading-edge searches on this screen, you should always enter as many characters as possible to limit the number of productions returned, otherwise your search 
request may take a long time to be processed. You can also limit the number of results by entering data into multiple fields.

Client Name/Identifier: Enter a record company’s name (or APRA/AMCOS-assigned client ID, if known) to help limit the results returned. 

If your search term(s) result in only one production being found, the Production Details window will automatically be opened to display that production (see page 25 for further details). 
If multiple productions are found to match your search terms, you can sort them on the screen by clicking any of the column headers, and you can also use either the ‘Keyword’ or the 
‘Find’ function to help you locate the production you wish to see.

With a production on the list highlighted, clicking the ‘Client’ button will display the Client window for that production (see page 18 for further details). 

When you have found the production you wish to view, double-click it to open the Production Details screen.
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PRODUCTION DETAILS SCREEN

The Production Details screen opens by default on the Tracks tab, and the following information is displayed:

The top section of this screen shows the details of the production - title, artist, catalogue number, format, number of discs/tracks, etc.

The middle section shows the works selected from CMS which have been attached to the production, complete with disc/track number, title and writer information, and various other 
fields – for full details on these fields, see notes to the right of the screenshot.

The bottom section shows, for the highlighted track, the data entered by the client. It is this data that has been run through the automatic matching process and then manually checked 
by CF staff.

The buttons at the foot of the screen allow you, for the highlighted track, to open the All Claims window to view all current mechanical ownership details (see page 12 for further 
details), to open the Claiming window to add a claim/disclaim/request a substitution (see page 13) or to add a new registration (see page 22).
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FIELD EXPLANATIONS

Type: track type, either ‘A’ for Audio or ‘V’ for Video – 
effective only for Mixed Format productions (see page 3 for 
further details)

Alert: ‘Y’ indicates that there may be a comment attached 
to the work which may be of relevance (NOTE: not all 
comments on works in CMS are visible to publishers – 
some are for internal APRA/AMCOS use only)

Disp: ‘Y’ indicates a mechanical dispute on the work (total 
mech ownership exceeds 100%)

MREG: ‘Y’ indicates that there is an active registration (for 
any publisher) attached to the work

MDOF: ‘Y’ indicates that the work has an MDOF

MROC: ‘Y’ indicates that there is an MROC (for any 
publisher) attached to the work. 

NOTE: If any of the MREG/MROC/MDOF fields show ‘Y’,  
clicking the All Claims button will display full current  
ownership details for the highlighted work. 

PDOF: ‘Y’ indicates that the work has a PDOF.

APRA ID: shows the ID number assigned to the work in 
CMS.
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As well as the Tracks tab, there are also 5 further tabs on the Production Details screen, which allow you to view the following information:

Tab 2: Client [CTRL + 2]

Displays details of any Category 1, 2 or 3 clients who have attached their release details to the production, showing their release date, price (or PPD code), etc. and the status of the 
production relative to each individual client (see page 2 for further information on production status).

NOTE: If sales have been reported for this production by Digital Delivery clients, these are shown on tab 6 (see page 28) – Digital Delivery clients are not displayed on the Client tab.

Tab 3: PN [CTRL + 3]

Allows you to view any available Prescribed Notices which exist for the production:

By default, the most recent PN for the production’s Primary Owner is displayed first. Earlier PNs for that client, as well as PNs for any other clients attached to the production can be 
viewed by clicking through the list in the top section of the screen. 

The middle section of this screen shows the works attached to the production, and the bottom section shows, for the highlighted work, the current mechanical sharers. Clicking the ‘All 
Claims’ button at the foot of the screen will show further details about that ownership, i.e. whether the ownership is represented by an MROC or by MDOF shares (see page 12 for 
further details). Clicking the Claim button opens the Claiming window for the highlighted work, allowing you to add a new MROC, disclaim the work, or request a substitution (see page 
13) and clicking the New Reg button allows you to enter a registration for the highlighted work (see page 22).
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Tab 4: History [CTRL + 4]

This tab displays some details of the progress of the production through CF, e.g. date of submission, creation of PN(s), etc.

Tab 5: Cat 2/3 Sales [CTRL + 5]

If the production in question has been released by a Category 2 or 3 client, this tab will show whether or not they have reported sales for the production (quantity/value of reported 
sales is not displayed here). If royalties have been distributed on the production, the distribution number is shown here:
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Tab 6: DSP Sales [CTRL + 6]

If sales have been reported for the production by a Digital Delivery client, the client details are displayed here:

For further information on the processing of Digital Delivery productions in CF, see page 45.

28



CMS/CF PUBLISHER USER MANUAL

CHECKING PRODUCTIONS VIA WORKS

If you want to check whether a specific work is attached to any productions in the Clearance Facility, you can do so by looking up the work from the Works Search screen:
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Double-click the work to 
open the Works 
Information screen…

Go to tab S3 [CTRL + SHIFT + 3] to view 
productions to which the work is attached. 
Double-clicking on a production here will open 
the Production Details screen.

Go to tab S3 [CTRL + SHIFT + 3] to view 
productions to which the work is attached. 
Double-clicking on a production here will 
open the Production Details screen.



CMS/CF PUBLISHER USER MANUAL

PUBLISHER EVENT NOTIFICATIONS

Notifications are created to alert you to significant events occurring to productions in the Clearance Facility, such as the creation of PNs, substitution of works on productions, 
production deleted/withdrawn by client. Some examples of these notifications can be seen in the screenshot below:

The Publisher Event Notifications screen offers three options. The first, ‘New Only’ displays all notifications that have been created since the last time you viewed this screen – once 
you have seen these notifications, you can either delete them using the ‘Delete Event’ or ‘Delete All’ buttons at the foot of the screen, or you can leave them and close the window. On 
closing the window, the ‘New only’ window is cleared... The second option, ‘View all’, displays all notifications that exist in CMS for you – again, the ‘Delete Event’ and ‘Delete All’ 
buttons at the foot of the screen can be used to remove any notifications that are no longer required.
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NOTE: Double-clicking on a 
notification opens the Production 
Details window for the production to 
which the notification refers.
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The third option, ‘File Transfer History’, is slightly different, and is only applicable to those publishers who use EDI to receive data from the Clearance Facility. The window displays 
details of any New Productions Extracts, Prescribed Notice downloads which you have requested and which have been sent to you within the last month, along with the details of any 
acknowledgement files sent in response to claims files submitted to CF, by you, via EDI. 

The purpose of this screen is to help you to track these files in case of any problems. If you have requested a New Production Extract or a Prescribed Notice download but not 
received the file, you should check this screen. If the file is shown here, that means that your request was received and has been processed, and the file has been sent to your FTP 
server (or to the output folder on the APRA/AMCOS server, if you do not have your own). The fact that you have not received the file indicates a problem on your side and you should 
speak to your IT department in the first instance. If the problem cannot be resolved and the original file cannot be retrieved, you should contact cmscf@apra.com.au with the filename 
listed here and ask for the file to be re-sent to you. 

If you have requested a download and no details are shown here, then this indicates that your request was not received, which in turn may indicate a problem on the APRA/AMCOS 
side. Please contact cmscf@apra.com.au and CF staff will provide further advice as soon as they are able.

31



CMS/CF PUBLISHER USER MANUAL

CLEARANCE FACILITY PUBLISHER REPORTS

There are two reports connected with CF that are available for publishers to run, and these can be accessed by clicking Processes > Reports and Updates [ALT + R + R]:

From the Publisher reports window, the dropdown menu offers the following options, the first and last of which are CF-related:
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DISPUTED MECHANICAL WORKS

This report lists all works* where you have an interest and where the combined MDOF and MROC shares for all publishers exceed 100%, thus putting the works into mechanical 
dispute, the purpose being to allow you to review your shares to see whether you should reduce your claim to resolve (or help to resolve) the dispute. If you wish to reduce your 
shares, you can either re-register the work (see page 22) or add a new MROC (see page 17).

[*NOTE: this report is not CF-specific – it shows all works in CMS which are in mechanical dispute, whether or not they are attached to CF productions.]

You have the option to run a ‘Full’ report, showing all works which are in mechanical dispute, or an ‘Incremental’ report, which shows all works which have gone into dispute since a 
specified date.
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There are three modes available for running this report:

Screen: the works are shown in the lower pane of the window 
so you can review them without printing the report

Printer: sends the report directly to your printer.

To Disk: creates a data extract of the disputed works, in tab-
delimited text format, which you can use in drilldown mode in 
CMS (see page 41 for details) or which can be opened in a text 
or spreadsheet program, allowing for manipulation of the data 
according to your requirements. 

The screenshot on the left shows the report as run in ‘To Disk’ 
mode. The location of the data extract that is created is shown in 
italics (new location is generated each time the report is run in 
‘To Disk’ mode). Double-clicking on the location opens the 
extract in drilldown mode in CMS, as shown on the following 
page.

The works reported are also shown in the lower section of the 
screen, as they are when the report is run in Screen mode, and 
can also be printed from this screen if required. 
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When the Disputed Mechanical Works report has been run in ‘To Disk’ mode, double-clicking the filename that is generated opens the extract in drilldown mode, as shown in the 
screen shot below. Select ‘Work by ID’ from the CMS System dropdown and double-click the ID number in the first column to open the Works Information screen for that particular 
work, and from there you can add a registration.
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WORKS WITH CLAIMS and MROC TIMEBOMBING

This report shows all works on which you have an MROC attached but no (active) registration. MROCs have a 
lifespan of six months only, after which time they are deleted by CF staff in a process known as MROC 
Timebombing, so it is essential that you keep track of your MROCs and follow them up with registrations before the 
timebombing process is run.

The timebombing process is run monthly. In general, the deadline for registrations to be submitted is the first Friday 
of each month. In the week following that deadline, CF staff will process new registrations received, and then the 
timebombing will be run to remove any MROCs which are six months old (or older) as of the last day of the 
preceding month, as per the schedule shown to the right.

So, following this schedule, in January, any MROCs submitted up to and including the 31st July the previous year 
are subject to removal; to run the report, you should set the ‘From’ date to 1st July and the ‘To’ date to 31st July (or 
later, if you also wish to look at MROCs which will be due for timebombing in future months). Ticking the ‘Include 
group structure’ box will ensure that MROCs for any subsidiary publishers you may have are also included.

As with the other reports, the MROC report can be run in Screen mode, or sent directly to the printer, and the 
results can also be saved as a data extract by clicking File > Save Data As [ALT F + S] – see page 41 for further 
information on how to use data extracts in CMS.

35

MROC TIMEBOMBING SCHEDULE

Month Week MROCs to be deleted for 
period ending previous…

January 3rd 30th  June
February 4th# 31st July

March 3rd 31st August
April 3rd 30th September
May 4th# 31st October
June 3rd 30th November
July 3rd 31st December

August 4th# 31st January
September 3rd 28th/29th February

October 3rd 31st March
November 4th# 30th April
December 3rd 31st May
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CLEARANCE FACILITY AND EDI

Various CF functions can be performed using EDI (Electronic Data Interchange), which allows data to be transmitted to/received from CMS/CF in bulk transactions via FTP. The 
following section will outline the functions that are available; for full details on the file formats, specific data included, etc, you should see the CMS/CF EDI Specifications document 
which can be obtained from the Downloadable Documents section on the APRA/AMCOS Publisher website (https://www.apra.com.au/site/publisher/logon.stm).

The Clearance Facility EDI menu can be accessed by clicking on File > Clearance Facility > EDI [ALT + F + L + E]:

There are four EDI functions available: PN Download, New Productions Download, Delete File From APRA FTP Site, AMCOS Dispute Account Extract.

PN Download - allows you to download PNs for productions, with various filters available.

New Productions Download – allows you to view new productions entered into the Clearance Facility.

Delete File From APRA FTP Site – allows users who do not have their own FTP server, and have their downloads sent to the output folder on APRA’s FTP server, to delete files that 
are no longer required.

AMCOS Dispute Account Extract – allows you to download a list of works in which you have an interest and which are in mechanical dispute.
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PN DOWNLOAD

There are four options available for PN downloads:

Full – PNs for all productions in CF on which you currently have mechanical shares

Incremental – all PNs created since your last PN download

Date – PNs created within a specified date range

Specific – enter the APRA-assigned production ID to get the PN for that specific production

For further details on this extract, please see section 6 of the Clearance Facility EDI Specifications document.
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NEW PRODUCTIONS DOWNLOAD

There are four options available for New Productions downloads:

Full – THIS DOWNLOAD IS OBSOLETE

Incremental – all productions that have been made available for viewing since your last download

Date – all productions that have been made available for viewing within a specified date range

Specific – enter the APRA-assigned production ID to get details for that specific production

For further details on this extract, please see section 4 of the Clearance Facility EDI Specifications document.
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DELETE FILE FROM APRA FTP SITE

This function only applies to those users who do not have their own FTP server and who therefore use the output folder on the APRA FTP server to store the EDI files received from 
APRA. 

Files in the output folder on the APRA FTP server are not deleted as a matter of course, so it is up to the users to remove files once they have finished with them. Unwanted files can 
be deleted by entering the filename here:

AMCOS DISPUTE ACCOUNT EXTRACT

This produces an extract showing all works which are attached to CF productions where the total mechanical ownership exceeds 100% and you have an interest. For full details of the 
extract, please see section 10 of the Clearance Facility EDI Specifications document.
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EDI AND THE PUBLISHER WEBSITE

The EDI functions described in the previous pages can also be accessed through APRA’s publisher website (https://www.apra.com.au/site/publisher/logon.stm)...

40

…and you are also able to 
change your EDI password 
and FTP server details 
here:
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WORKING WITH DATA EXTRACTS IN CMS

CMS allows the publisher reports, as well as the data from many other screens, to be saved as data extracts in a number of different file formats – tab-delimited text, CSV, Excel, 
HTML, etc. Being able to save the data in this way means that you can forward reports, etc. to other offices within your company very easily. 

The saved data extracts can be opened using text or spreadsheet programs, allowing you to manipulate the data to suit your needs, and you are also then able to re-open the data 
extract within CMS and use the ‘drilldown’ function to work with the data in a number of ways. 

The Disputed Mechanical Works report has a built-in ‘To Disk’ function for the creation of data extracts; for other reports/screens, you can create an extract manually by clicking File > 
Save Data As… [ALT + F + S] or right click with your mouse and select “Save Data As…”
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When you click Save Data As… and the 
‘Save As’ dialogue box appears, the 
default location should be the CMS 
Extracts folder on your hard drive, but of 
course you can change the location as you 
wish. The ‘Save as type’ dropdown allows 
you to select from a wide range of different 
file types.
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The saved file can be opened in Notepad, Excel, etc., in order to view and manipulate the data:

and can then also be reopened in CMS by clicking Options > Open Database Extract file [ALT + O + O]:
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Once the extract has been opened, select ‘Work by ID’ from the CMS System dropdown and double-click on the APRA ID number of a work to open up the Publisher Registration 
(Works Information) screen, from where you can add a registration, or access the production(s) to which the work is attached in order to disclaim, change your MROC, etc.:
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APRA/AMCOS CF REPORTING

There are a number of reports run by APRA staff to ensure that ownership claims are kept up to date: 

• New registrations attaching to works on productions (reported daily)
• Works with pre-existing active registrations, that are attached to productions which are due to receive their first PN that night (run daily)
• Substitution requests submitted by publishers (run daily) 
• Disclaim works requests submitted by publishers (run daily)

Other reports show works which are:

• Works that have been put into dispute by the addition of MROCs  
• Works which have been in dispute but where the total ownership is now less than 100%
• Works where the same publisher has an MROC and an MDOF share for different percentages
• Works that have total ownership percentage between 99.8 and 100

Every effort is made to process ownership updates as quickly as possible, but if you have any queries about the update of your ownership on a work, you should contact 
mech@apra.com.au with full details.

44



CMS/CF PUBLISHER USER MANUAL

PROCESSING DIGITAL DELIVERY PRODUCTIONS IN CMS/CF

INTRODUCTION

The processing of Digital Delivery (DD) productions – albums made available for download by Digital Service Providers (DSPs) via the internet – through the Clearance Facility began 
in early 2006. By the time of writing this manual (October 2006), iTunes alone have sales figures attached to over 20000 productions*, over twice as many as the largest physical 
product client. (*This figure includes productions originally submitted by physical product clients, to which iTunes have been attached, as well as productions created specifically for 
iTunes.) 

Given the volume of productions being reported by DSPs, a different means of processing these productions had to be derived – it is not possible for every DD production reported to 
CF to be edited in the same way as productions submitted by physical product clients. The following pages outline how digital delivery productions are treated in CF. There are two 
sections, based on the fact that for APRA/AMCOS’ purposes, digital delivery clients are divided into two types, MI3P and non-MI3P. The former use the Music Industry Integrated 
Identifier Project standards when reporting their sales, which means that they include a range of information about their productions and the tracks included on them, which in turn 
allows their productions to be created in CF in a different way from those for clients not using those standards. 

NON-MI3P CLIENTS

STAGE 1 – SALES REPORTS AND PRODUCTION MATCHING 

AUTOMATED MATCHING PROCESS

When submitting sales reports for DD productions to APRA/AMCOS, the client or DSP includes, amongst other things, the production’s title, performer and the number of tracks. In the 
first stage of processing of the sales report, an automated matching process attempts to match the productions reported to existing productions in CF, using this information.

If a match is found, the DSP’s sales are recorded against the existing production. The DSP is not attached to the production in the same way as other CF clients, i.e. they are not 
added to the Client tab in CMS. Instead, the sales are registered on the DSP Sales tab, and this will happen each time that a DSP reports sales for the production. No new PN is 
created when DSP sales are attached to a production.

MANUAL MATCHING PROCESS

The automated matching process may fail to pick up matches between productions reported by the DSP and existing productions in CF due to spelling errors, differences in the 
formatting of titles/performer names, etc. An exception report lists all productions which were not matched by the automatic process, and a manual check is carried out on any 
productions for which the value of the sales report exceeds the Board-determined threshold for DD productions (more information on the threshold follows). If a match is found in CF, 
then the sales are logged against the existing production in the same way as for the automated matching process.

From both the automated and the manual matching process, an ‘experience file’ entry is created when the match is made, so that if the client reports the same production in the same 
way in future, it will automatically be matched to the correct production.

If after both the automated and the manual checks have been carried out, no match has been found in the Clearance Facility for a production submitted by a digital client, then a new 
production is created, with the DSP as the Primary Owner. 
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*NOTE: Most functions within CMS can be 
accessed using keyboard shortcuts. 
Throughout this manual, where instructions are 
given for navigating around CMS, mouse-click 
options will be given first, with  the keyboard 
shortcuts shown italicised in square brackets 
following, 
e.g. click File > Clearance Facility [ALT F + L]
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STAGE 2 – CREATION OF PRODUCTIONS

The priority at this stage in the process is to get the invoicing/payment cycle under way, so initially, all that is created is a production ‘shell’, containing the essential header details that 
are required for invoicing, such as title, performer, number of tracks, catalogue number (if provided), label details (if provided). The screenshot below shows what one of these 
production shells looks like:
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Notes

1) The Category used for DD productions is Audio

2) The format is Digital Delivery

3) The digital client is shown as the Primary Owner

4) Catalogue numbers are not mandatory – where none is provided, 
‘UNKNOWN’ is entered

5) The status of the production is New

6) There is no submitted date

7) No tracks are added at this stage

When these production shells have been created in CF, the client is invoiced. 
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STAGE 3 – ASSESSMENT OF THE VALUE OF PRODUCTIONS

Once the production has been marked as invoiced, the next stage is to assess it against the DD Royalty Threshold as to whether tracks need to be added to it or not.  If the value of 
the production is below the threshold, the production will not enter into the distribution, so there is no immediate need to add works details. If the production is over the threshold, then 
in order for royalties to be distributed, the works included need to be identified and attached. 

Because the volume of titles being reported by DSPs is very high, and the average number of sales per production is very low, it is neither practical nor possible for all productions to 
be researched and have tracks added as a matter of course. The APRA and AMCOS Boards have therefore approved thresholds for digital delivery sales, allowing APRA/AMCOS and 
publishers to focus on the larger revenue-generating DD productions. Research will be carried out on, and tracks added to, only those productions where the value from sales exceeds 
the threshold, and this will be assessed in two stages. 

PRE-DISTRIBUTION

A report is run regularly by CF staff which lists all the unique (non-MI3P) DD productions which have been invoiced, and which currently have no tracks attached to them, along with 
their combined APRA/AMCOS royalty value. If the value of any production from an individual sales batch exceeds the agreed threshold, it is examined by CF staff. 

If it is found that the production already exists in CF (i.e. it was missed by the previous matching processes, or has been submitted as a physical product by another client in the 
intervening period), the DD production is transferred to the existing one. If there is no match in CF, then the production is researched to determine the correct tracklisting, and the 
correct tracks are added.

Once the tracks have been added, the production is marked as Edited and then submitted, thus making it available for publishers to view via the EDI ‘New Productions Extract’ 
download and/or the ‘Claim By Production’ or ‘Claim By Work’ screens in CMS (further information on how to use this screen to view DD productions follows).

When DD productions do become visible by these means, it is important that publishers check the details carefully. The tracklistings for these productions are taken principally from 
the DSPs’ websites (although there may also be cross-referencing with other sources where necessary). Most of these sites provide only track titles, with no writer or publisher 
information. While CF staff obviously make every effort to match the titles listed to the correct works, it should be kept in mind that the information provided is significantly less detailed 
than is normally the case and that in some cases, the productions concerned may be somewhat obscure, which can make it harder to find and confirm details.

POST-DISTRIBUTION

Immediately prior to the running of each of the two annual APRA and the four annual AMCOS distributions, all productions which were not matched via the automated and manual 
processes, and so were newly created from DSP sales reports, and for which the sales reported did not exceed the threshold, (and which therefore did not have tracks added to them), 
have dummy works added instead. 

These dummy works are assigned new GW numbers and titles are created for them based on the APRA production ID and their track number, e.g. AU00548171Track1, 
AU00548171Track2, etc.

Dummy works are added so that the relevant royalties can be allocated and properly accrued in the APRA suspense and AMCOS control accounts, and dummy titles are assigned to 
these works to ensure that they are not used for any other purposes, i.e. they do not have performances attached to them, or get attached to other CF productions.
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While a digital production may not have generated enough money in one sales batch to take it over the threshold, sales may accrue over several sales batches and/or several periods, 
and it may thus exceed the threshold over time. Another report run by CF staff shows the accrued values of DD productions so that those that have come to exceed the threshold can 
be identified. For these productions, the proper tracklisting is researched. If the works on the production already exist in CMS, then the dummy tracks are transferred to the existing 
works; if there is no pre-existing work in CMS, the title/writer/etc fields of the dummy work are amended to show the correct details. Money that was allocated to a dummy work in the 
AMCOS control account is paid out in the next distribution, providing that the ‘new’ work has mechanical ownership claims attached.

Once the correct tracklisting has been established, a final check is done to see whether the DD production can be matched to an existing production in CF (again, the previous checks 
may have failed to pick up a match, or the physical product may have been submitted in the mean time). If a match is found at this stage, the DD production will be transferred to the 
other.

If there is no match in CF, then the edited production is submitted, thus making it available for viewing by publishers via either the ‘New Productions Extract’ download or the ‘Claim By 
Production’ or ‘Claim By Work’ screens in CMS (see section Publisher Tasks below for further details). 

MI3P CLIENTS

[NOTE: While it is anticipated that most/all digital clients will, at some point in the future, take up the MI3P standards, at the time of writing, iTunes are the only client supplying data to 
APRA/AMCOS in this format. For this reason, and for convenience, the information below refers to iTunes. As further clients take up the MI3P standards, we will inform you of this,  
and the information below can be taken to apply to all MI3P clients, not only iTunes.]

The procedure for productions submitted by iTunes is slightly different from that for other DSPs – because iTunes are using the MI3P standards when submitting their sales data to 
APRA/AMCOS, along with their sales information, they also supply a range of metadata relating to their productions. This metadata includes, among many other things, not only the 
title and performer information for each production, but also the title, performer and (in some cases) writer details for each track featured on those productions.

The additional information provided by iTunes is used to populate their productions with track details, rather than merely creating trackless shell productions as per the other DD 
clients. When sales batches from iTunes are processed, therefore, the relevant parts of the metadata are run through the same works-matching algorithm as is used for standard CF 
productions, and works are added to the productions based on the results.

The same production threshold applies to iTunes productions as to those from other DD clients. CF staff run a report on a regular basis to show all iTunes productions which are over 
the threshold. All such productions will first be checked to see whether the ‘physical’ version of the production already exists in CF; if so, the iTunes production will be merged with the 
existing one, as per the procedure for other DD clients). If they are found to be valid separate productions, the tracks added from iTunes’ metadata will be edited to ensure that the 
correct works have been attached.

Once this has been completed, the productions will be marked as Edited and then submitted, making them available for viewing by publishers.
 
Although they provide more information than the other digital clients, the details provided by iTunes are still, as a general rule, less comprehensive and less accurate than those 
insisted on for ‘normal’ CF submissions. For instance, while title and performer information is largely reliable, the same is not necessarily true for writer details. Many tracks have no 
writer information included, so the works matching process has to be carried out with reference only to the title and performer. If no match can be made for a track using the iTunes 
data, a new work record is created in CMS automatically, using the title and performer details, along with whatever writer information was supplied, or with ‘UNKNOWN’ in the writer 
field if none was provided. 

As stated above, if the value of sales recorded against an iTunes production exceeds the threshold, then this information will be checked and corrected as part of the editing process. 
While CF staff make every attempt during the editing process to ensure that the correct works have been attached, publishers should also check these productions carefully and bring 
any possible errors in matching to the attention of CF via the normal means.
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If the value of an iTunes production falls under the threshold, then the attached works will remain unedited in CMS until such time as either the production accrues sufficient sales to 
take it over the threshold, or the works attract attention from other sources (e.g. have performances, cuesheets, etc, attached). 

If works attached to such productions as a result of the processing of the iTunes metadata have mechanical ownership details, mechanical royalties will be distributed on them. 
Although the productions themselves will not be made visible through CF, any applicable works will be listed on royalty statements. If you want to query any such payments, or believe 
that incorrect payment has been made, you should contact cmscf@apra.com.au with further details.

PUBLISHER TASKS

CLAIMING/REGISTERING WORKS

In most respects, works attached to DD productions should be treated in the same way as works attached to any other production in CF. MROCs can be made for such works and will 
be subject to the normal expiry period of six months, but given that both Mechanical and Performing royalties are to be distributed, registrations should be submitted wherever 
possible, and will certainly need to be submitted prior to the cut-offs for APRA distributions. 

Substitution requests can also be entered for works incorrectly attached to DD productions.

VIEWING DD PRODUCTIONS IN CMS

If DSP sales are attached to an existing production which has an active PN, the production is not made available to publishers via the EDI ‘New Productions Extract’, as it is assumed 
that all claims have been made and are up to date. Publishers are able to view such productions by using the ‘Claim By Production’ or ‘Claim By Works’ screens in CMS.

If DSP sales are attached to an existing production which has been marked as Deleted, however, that production is automatically resubmitted, and the status reset from Deleted to 
Pending. Such productions will be reported in the EDI ‘New Productions Extract’ so that will be able to reassess their claims on works which may otherwise have been dormant for 
some time. For those publishers not using this download, these productions can also be viewed via the ‘Claim By Production’ or ‘Claim By Works’ screens in CMS.

All productions which were originally submitted as physical product and which have since had DSP sales attached to them can be seen by publishers. However, as stated previously, 
only those ‘unique’ DD productions which have received sufficient sales to take their value over the threshold, and have had tracks added to them and been submitted by CF staff will 
be made visible to publishers for claiming.

There are three screens in CMS via which DD productions can be viewed…
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1) CLAIM BY PRODUCTION
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2) CLAIM BY WORK 
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3) PRODUCTION INQUIRIES

NOTE: Clicking the ‘Client’ button on either the “Claim by Production” or “Claim by Work” 
screen will open the Client window, displaying all clients – digital delivery and otherwise – 
currently attached to the selected production – see screenshot (right) for example.
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